
 Worksheets 

1. Number System
A. Fill in the blanks.

 1. Decimal number system is the most commonly used _________________.

 2. The positional value of each digit increases as we move from_______________.

 3. The language understood by a computer is the __________ language.

 4. The base of octal number system is _________.

 5. The ______________________ system consists of 16 digits and has a base of 16.

B. State whether the following statements are True or False. 

 1. The rightmost digit of a number is called the most significant digit.

 2. The binary number system consists of two digits, i.e., 0 and 1.

 3. Some examples of octal number system are 57A and 45D.

 4. Binary addition is not similar to addition of decimal numbers.

 5. In Binary addition, if the sum of two numbers exceeds 1, a carryover is generated.

C. Match the columns.

  Column A  Column B

 1. Binary Number System (a) (25)10

 2. Octal Number System (b) (4D2)16

 3. Hexadecimal Number System (c) (345)8

 4. Decimal Number System (d) (11001)2

D. Explain the following.

 1. Decimal Number System

 2. Binary Number System

 3. Octal Number System

 4. Hexadecimal Number System

E. Answer the following questions.

 1. Write the steps to convert Decimal Number System into Binary Number System.

 2. Write the steps to convert Binary Number System into Decimal Number System.

 3. Write the steps to convert Octal Number System into Decimal Number System.

 4. Write the steps to convert Hexadecimal Number System into Decimal Number System.



Answers to Worksheet

A. 1. number system  2. right to left   3. binary
 4. eight   5. hexadecimal number
B. 1. False 2. True 3. False 4. False 5. True
C. 1. (d)  2. (c) 3. (b) 4. (a)
D. 1. Decimal Number System: Decimal number system is the most commonly used number 

system. For example, to know the number of student in your school, you simply count the 
students one by one. The number system used here is the decimal number system. The 
decimal number system consists of 10 digits. So, the base of the decimal number system is 
10. It consists of digits from 0 to 9, for example, 82, –256 and –567. Any quantity greater than 
9 is represented by a contribution of two or more digits.

 2. Binary Number System: The binary number system consists of two digits, i.e., 0 and 1. Hence, 
the base of binary number system is 2. The language understood by a computer is the binary 
language. Therefore, the instructions given to a computer are converted into the binary 
language.

 3. Octal Number System: The octal number system consists of 8 digits, i.e., 0 to 7. Hence, the 
base of octal number system is 8. Some examples of octal number system are 527 and 45.

 4. Hexadecimal Number System: The hexadecimal number system consists of 16 digits, i.e., 0 
to 9 digits and letters A to F, where 10 represents A, 11 represents B, 12 represents C, 13 
represents D, 14 represents E and 15 represents F. Thus, the base of hexadecimal number 
system is 16. Some examples of hexadecimal number system are 54A, 64A and 4D2.

E. 1. Follow these steps to convert decimal number system to binary number system.

 • Step 1: Divide the given number by 2.

 • Step 2: Write down the remainder and divide the quotient again by 2. The steps are 
repeated till the quotient becomes zero.

 2. Follow these steps to convert binary number system to decimal number system.

 • Step 1: Multiply each digit with its positional value, which is in terms of powers of 2, starting 
from the extreme right digit.

 • Step 2: Increase the power one by one, keeping the base fixed at 2.

 • Step 3: Add all the products to get the decimal number.
 3. Follow these steps to convert octal number system to decimal number system.

 • Step 1: Multiply each digit with its positional value, which is in terms of power of 8, starting 
from the extreme right digit.

 • Step 2: Increase the power one by one, keeping the base fixed at 8.

 • Step 3: Add all the products to get the decimal number.
 4. Follow these steps to convert hexadecimal number system to decimal number system.
 • Step 1: Multiply each digit with its positional value, which is in terms of power of 16, 

starting from the extreme right digit.
 • Step 2: Increase the power one by one, keeping the base fixed at 16.
 • Step 3: Add all the products to get the decimal number.



2. Charts in Excel 2016
A. Fill in the blanks.
 1. A _________ is a pictorial representation of data.
 2. X axis is the horizontal axis of a chart and is also known as the _____________.
 3. ___________ provides additional information about a data marker which represents a single 

data item or value coming from a worksheet cell.
 4. A __________ is in the form of lines that compares trends in data at equal intervals.
 5. ______________ is used when values being charted represent different measurements.

B. State whether the following statements are True or False. 
 1. A chart can be two dimensional or three dimensional.
 2. A pie chart is used to plot the data for a single data series.
 3. A scatter chart shows comparison among individual items through a cluster of bars.
 4. To make a chart, we need to first enter data into a worksheet.
 5. Chart area refers to all the objects of a chart.

C. Match the columns.
  Column A  Column B
 1. X axis (a) Headings given to X axis and Y axis
 2. Y axis (b) All the objects of a chart
 3. Axis title (c) Value axis
 4. Chart area (d) Category axis
 5. Legend (e) Identifies each data series

D. Label the different components in the following graph.

E. Answer the following questions.

 1. Write the advantages of charts.
 2. Describe the components of a chart.
 3. Write the two methods of creating a chart.
 4. What are Chart Tools?
 5. What is a Column Chart?



Answers to Worksheet

A. 1. chart 2. category axis 3. Data label 4. line chart 5. XY scatter chart
B. 1. True 2. True 3. False 4. True 5. True
C. 1. (d)  2. (c) 3. (a) 4. (b) 5. (e)

D.  

Legend

X axis

Chart Title

Chart Area

Gridlines

Y axis

E. 1. Following are the advantages of Charts.

 • Charts are more attractive than simple presentation of data.

 • Charts are easy to compare and understand.

 • They present data in a compact manner.
 2. The various components of a chart are as follows.

 • Data Series: It refers to the data entries from which a chart is derived. A chart can have one 
or more than one data series.

 • X axis: It is the horizontal axis of a chart and is also known as the category axis.

 • Y axis: It is the vertical axis of a chart. The value of each data point is plotted on this axis. It 
is also known as the value axis.

 • Chart Title: It helps the users to understand what the chart represents. It is usually placed 
at the top of a chart.

 • Axis Title: These are the headings given to X axis and Y axis. It helps in understanding what 
the axis depicts.

 • Chart Area: It refers to all the objects of a chart.

 • Plot Area: It is the rectangular area bounded by the two axes where the chart is plotted. 
The X axis and Y axis define the two sides of a rectangular plot area.

 • Legend: It identifies each data series. A unique colour or pattern is assigned to each data 
series to make it easier to distinguish between them visually.

 • Gridlines: They are lines that run from each category on the X axis and from each value on 
the Y axis across the plot area.



 • Data Label: This is a label that provides additional information about a data marker which 
represents a single data item or value coming from a worksheet cell.

 3. To make a chart, we need to first enter data into a worksheet. After the data is entered, there 
are two methods to create a chart.

  Method 1: Select the cells and press the F11 key. Excel will automatically create a chart for 
you. This is the shortest way of creating a chart.

  Method 2: Follow these steps to create a chart of your choice.

 • Select the cells within the table.

 • Click on the Insert tab on the ‘Ribbon’.

 • Select the type of chart you want from the ‘Charts’ group. The selected chart will get 
displayed in your sheet. 

 • Click on the Design tab. In the ‘Chart Styles’ group, click on the More button to view all the 
available styles.

 4. The Chart Tools appear on the Ribbon when you click on the chart. The tools are located on 
two tabs namely Design and Format.

 • From the Design tab, you can choose the Chart Type, Chart Layout, Styles and Location.

 • Under the Format tab, you will fi nd many options to modify the Shape Styles, WordArt 
Styles or Size of the chart.

 5. A column chart is useful for showing data changes over a period of time or for illustrating 
comparisons among items. It is a commonly used chart type to display data in the form of 
vertical bars. In column charts, categories are typically organised along the horizontal axis 
and values along the vertical axis. These charts are used to compare values across different 
categories.



3. More on Small Basic

A. Fill in the blanks.

 1. _________________ are used to control the flow of a program.

 2. A control structure is broadly categorised into two types: ___________________ and 
______________________.

 3. The simplest control structure is the ___________ statement.

 4. In the ____________ statement structure, if the condition given is ‘True’, then the statement 
specified after ‘Then’ is executed.

 5. _________________ transfers the program control from one statement to another.

B. State whether the following statements are True or False. 

 1. If ElseIf ladder is used to check multiple conditions in a program.

 2. Control is a process of executing a block of statements again and again.

 3. A loop must only have a starting condition and a terminating condition is not required.

 4. The While loop is used when a group of statements is to be executed a specific number of 
times.

 5. A subroutine cannot be written anywhere in a program.

C. Match the columns.

  Column A  Column B

 1. For loop (a) Repeats the instructions until a given  
  condition is ‘true’

 2. While loop (b) Transfers the program control from one  
  statement to another

 3. Goto statement (c) Check multiple conditions in a program

 4. If ElseIf ladder (d) Simplest control structure

 5. If Then statement (e) To execute a group of statements a  
  specific number of times

D. Choose the correct answer.

 1. Which of the following is used to make decisions and act accordingly?

 (a) Conditional control structure

 (b) Control conditional structure

 (c) Structural conditional control

 (d) Condition controlling structure



 2. Which of the following is used to check multiple conditions in a program?

 (a) Goto   (b) Looping

 (c) If Then   (d) If ElseIf

 3. Which of the following is the simplest control structure?

 (a) If Then Else   (b) If ElseIf

 (c) If Then   (d) Goto

 4. Which of the following is used when a group of statements is to be executed a specific 
number of times?

 (a) If Then Else   (b) If ElseIf

 (c) For loop   (d) Goto

 5. Which of the following is used to repeat the instructions until a given condition is ‘true’?

 (a) If Then Else   (b) While loop

 (c) For loop   (d) Goto

E. Answer the following questions.

 1. Write the syntax of For loop.

 2. What is looping?

 3. What are the types of control structure?

 4. Write a short note on If Then statement.

 5. Write a short note on If ElseIf ladder.



Answers to Worksheet

A. 1. Control structures 2. Conditional control structure, Looping control structure
 3. If Then   4. If Then Else   5. Goto statement
B. 1. True 2. False 3. False 4. False 5. False
C. 1. (e)  2. (a) 3. (b) 4. (c) 5. (d)
D. 1. (a)  2. (d) 3. (c) 4. (c) 5. (b)
E. 1. The syntax of For loop is as follows.
  For <Control variable> = <Initial value> To <Final value>
 2. While programming, there comes a certain situation in which you need to repeat one or 

more statements a number of times. This can be done by using loops. Looping is a process of 
executing a block of statements again and again.

 3. Control structures are used to control the flow of a program. A control structure is broadly 
categorised into two types.

 • Conditional Control Structure

 • Looping Control Structure
 4. The simplest control structure is the If Then statement. It checks only the ‘True’ condition of 

the program and comes to an end. Let’s understand If Then statement with a syntax and an 
example.

  Syntax:
  If <Condition> Then
  <Statement>
  EndIf
  If the condition is ‘True’, then the instruction specified after Then is executed. If the condition 

is ‘False’, there will be no output for the If block, and the control will transfer after the EndIf 
statement.

 5. If ElseIf ladder is used to check multiple conditions in a program. This can be executed by 
including multiple ElseIf statements. In an If ElseIf ladder, statement inside an Else block is 
executed only when all the conditions that come before it in the ladder are ‘False’. But at a 
time only one condition can be executed. Let’s understand If ElseIf ladder with a syntax and 
an example.

  Syntax:
  If <Condition> Then
  <Statement 1>
  ElseIf <Condition> Then
  <Statement 2>
  ElseIf <Condition> Then
  <Statement 3>
  Else <Statement 4> 
  EndIf



4. More on Flash CS6
A. Fill in the blanks.

 1. _________ is used for developing interactive websites, computer games, etc.
 2. By default, the Stage dimensions are _________ pixels.
 3 _____________ contains tools for zooming the application window.
 4. ______________ organises and controls a document’s content in layers and frames.
 5. ___________ displays the properties of the selected object.

B. State whether the following statements are True or False. 

 1. Some features like copying and pasting are also present on the Menu bar.
 2. Layers can be defined as little rectangular cells that appear on the timeline.
 3. Transforming is done by using the Free Transform Tool.
 4. Grouping means slanting the object to a specific angle along one or both the axes.
 5. The copy of the symbol is called an instance.

C. Match the columns.

  Column A  Column B

 1. Tools Section (a) Contains tools for zooming the application window

 2. View Section (b) Organises document’s content in layers and frames

 3. Colours Section (c) Displays modifiers for the currently selected tools

 4. Options Section (d) Includes modifiers to select colours for the shape you draw

 5. Timeline panel (e) Contains tools used for drawing and painting

D. Label the components of a Flash window.

E. Answer the following questions.

 1. Write the steps to start Flash.
 2. Name the different components of Flash window.
 3. Write the steps to transform the shape of an object.
 4. Write the given steps to group an object.
 5. What is skewing? Write the steps to skew an object.



Answers to Worksheet

A. 1. Flash   2. 550 × 400   3. View section
 4. Timeline panel   5. Property Inspector
B. 1. True 2. False 3. True 4. False 5. True
C. 1. (e)  2. (a) 3. (d) 4. (c) 5. (b)

D. 

Timeline Panel

Property 
Inspector

Tools Panel

Layers

Stage

Title Bar
Menu Bar

E. 1. Follow these steps to start Adobe Flash.
 • Click on the Start button.
 • Scroll down the list and select Adobe Flash Professional CS6. The ‘Flash’ screen appears.
 2. Following are the different components of a Flash window.
 • Stage 
 • Title Bar and Menu Bar 
 • Tools Panel 
 • Timeline Panel

 • Frames
 • Layers
 • Property Inspector

 3. Follow these steps to transform the shape of an object.
 • Draw a hexagon using the Polystar Tool.
 • Select the Free Transform Tool from the ‘Tools Panel’.
 • Double click on the shape drawn on the Stage. A bounding box will appear around it. Drag 

the handle on the top center of the box down to shrink the hexagon.
 4. Follow the given steps to group an object.
 • Select the object to be grouped using the Selection Tool.
 • Select the Group option from the ‘Modify’ menu. The object with its parts will be grouped 

together.
 5. Skewing means slanting the object to a specific angle along one or both the axes.
  Follow the given steps to skew an object.
 • Select the object using the Free Transform Tool.
 • Select the Transform option from the ‘Window’ menu.
 • A dialog box will appear. Click on the Skew radio button and enter values for Skew 

horizontal and Skew vertical angles.
 • Drag the center handle to skew the object and release the mouse button.



5. Animation and Layers in Flash

A. Fill in the blanks.

 1. _________ are the transparent sheets stacked on top of one another.

 2. ________________ is caused due to the phenomenon of persistence of vision.

 3. __________ means to hide and display the content on a layer.

 4. Animation in Flash can be done in three ways:___________, ____________ and Classic 
Tween.

 5. In ___________ you can make a shape appear like it is changing into another shape over 
time.

B. State whether the following statements are True or False. 

 1. Shape tween is used to change the colour of an object.

 2. Masking is the rapid display of a sequence of 2D and 3D images in order to create an optical 
illusion of movement.

 3. The active layer is highlighted in the Timeline and is indicated with an eye icon.

 4. The order of layers determines the order of different objects that appear on the Stage.

 5. To make a layer active, either select the layer in the Timeline or select a stage object in the 
layer.

C. Match the columns.

  Column A  Column B

 1. Motion Tween (a) Default layer shown in Flash

 2. Shape Tween (b) This layer guides the path to other layers

 3. Tint Tween (c) Colour of the object changes

 4. Normal Layer (d) Shape of the object appears to change

 5. Guide and Guided Layer (e) Object moves from one place to another

D. Choose the correct answer.

 1. Which of the following icon lets you define the visible or invisible portion of the layer?

 (a) Masked layer   (b) Eye icon

 (c) Pen icon   (d) Tools bar

 2. Which of the following icons indicates the active layer that is highlighted in the Timeline?

 (a) Pen icon   (b) Eye icon

 (c) Pencil icon   (d) Lock icon



 3. ‘Click on the layer name you want to move and drag it to the required position.’ The given 
process performs which of the following actions?

 (a) Adds a new layer   (b) Renames a layer

 (c) Selects a layer   (d) Changes the order of a layer

 4. Which of the following is the colour if the dot under the ‘Lock’ column?

 (a) Red   (b) White

 (c) Blue   (d) Green

 5. Which of the following is the shortcut key for inserting a keyframe?

 (a) F1   (b) F2

 (c) F6   (d) F7

E. Answer the following questions.

 1. What are different types of layers in Flash?

 2. How do you select a layer in Flash?

 3. Why is a layer locked in Flash? Write the steps to lock a layer.

 4. Write a short note on masking. 

 5. What is the function of the motion tween?



Answers to Worksheet

A. 1. Layers
 2. Animation effect 
 3. Masking
 4. Motion tween, Shape tween
 5. Shape tween

B. 1. False 2. False 3. False 4. True 5. True

C. 1. (e)  2. (d) 3. (c) 4. (a) 5. (b)

D. 1. (a)  2. (c) 3. (d) 4. (b) 5. (c)

E. 1. There are three types of layers created in Flash.

 • Normal Layer: It is the default layer shown in Flash, where we can draw and animate an 
object.

 • Guide and Guided Layer: This layer guides the path to other layers. You can create an 
object of any shape in one layer and make it follow a path in another layer.

 • Mask Layer and Masked Layer: You can place a shape or symbol on a layer and select it as 
a mask layer by selecting the Mask option. The layer below the mask layer is the masked 
layer. The masked layer lets you defi ne the visible or invisible portion of the layer below 
the mask layer.

 2. Selecting a layer: To make a layer active, either select the layer in the Timeline or select a stage 
object in the layer. The active layer is highlighted in the Timeline and is indicated with a pencil 
icon.

 3. A layer is locked to avoid any further changes to the content added by you.
  Follow these steps to lock a layer.

 • Click on the layer which you want as the active layer.

 • Click on the white dot under the ‘Lock’ column. A lock icon will appear indicating that the 
layer is now locked.

 4. Masking means to hide and display the content on a layer. The mask layer contains a mask 
item, which can be a filled shape, a typed object, etc. It acts as a hole through which the 
content of the layer can be seen. Masking can be used to hide objects under a mask, create 
spotlight effects and transitions that display the text through a hole. 

 5. Motion tween refers to any object that travels from one point to another and involves no 
change in the shape or size of the object over a period of time. However, changes may occur 
in colour, texture or distance of the objects. This is one of the basic animation techniques.



6. More on Internet

A. Fill in the blanks.

 1. A __________________ is an online network-based website.

 2. ___________, ___________ and __________ are some examples of the most popular social 
networking sites used these days.

 3. Facebook also provides a ______________ to chat in real-time.

 4. ________ is a site that allows users to send and receive text-based messages.

 5. ______________ means storing, and accessing data and programs over the Internet instead 
of using computer’s hard drive.

B. State whether the following statements are True or False. 

 1. Cloud computing service is device dependent.

 2. The word ‘cloud’ refers to the Internet.

 3. Online sharing allows one and only one user to share a file through the Internet.

 4. Google Drive and Dropbox are some examples of paid cloud storage providers.

 5. A web browser is a software application which is used to access web pages on the Internet.

C. Match the columns.

  Column A  Column B

 1. Facebook (a) Text-based messages

 2. Twitter (b) Create a profile, invite friends, 
  and share pictures

 3. Google Drive and Dropbox (c) Uniform Resource Locator

 4. Graphical browsers (d) Free cloud storage providers

 5. Address bar (e) Netscape, Opera and Google Chrome

D. Choose the correct answer.

 1. The text-based messages on Twitter are called _________.

 (a) tweets   (b) greets

 (c) pings   (d) beets

 2. Which of the following buttons is used to load a webpage again?

 (a) Forward   (b) Back

 (c) Refresh   (d) Stop



 3. Which of the following stores recently viewed web pages to avoid downloading it again?

 (a) Webpage   (b) Web cache

 (c) Website   (d) Web address

 4. You can go to the previous page by clicking on the browser’s __________ button.

 (a) Forward   (b) Back

 (c) Refresh   (d) Stop

 5. ___________ button can be pressed to go back to the same page again.

 (a) Forward   (b) Back

 (c) Refresh   (d) Stop

E. Answer the following questions.

 1. Write the steps to upload and share a file in Google drive.

 2. What are the types of clouds available?

 3. Write a short not on the address bar.

 4. What are navigation buttons?

 5. Describe browsing history.



Answers to Worksheet

A. 1. social networking site

 2. Facebook, LinkedIn, Twitter

 3. messenger app 

 4. Twitter

 5. Cloud computing

B. 1. False 2. True 3. False 4. False 5. True

C. 1. (b)  2. (a) 3. (d) 4. (e) 5. (c)

D. 1. (a)  2. (c) 3. (b) 4. (b) 5. (a)

E. 1. Follow these steps to upload and share a file in Google drive.

 • Sign in into your G-mail account.

 • Click on the Google apps launcher.

 • Select the Drive icon. The ‘Google Drive’ will open.

 • Click on the My Drive icon.

 • Select the Upload files option from the drop-down list.

 • An ‘Open’ dialog box will appear.

 • Select the file you want to upload.

 • Click on the Open button.

 • A pop-up window will appear notifying the status of the file being uploaded.

 • The uploaded file will appear in the Google Drive folder.

 • Right-click on the uploaded file and select the Share option.

 • A pop-up window will appear. Enter the names or e-mail addresses of the people with 
whom you want to share the file. You can also give different access permission to the user 
by clicking on the drop-down arrow of the Pencil icon.

 • Click on the Send button to share the file.

 2. Various types of clouds are as follows.

 • Public Cloud: In public cloud, resources are made available to all the public over Internet. 
It is inexpensive and location independent.

 • Private Cloud: In private cloud, a cloud is maintained to be used by a single organisation. 
It provides a secure cloud-based environment and is more flexible.

 • Community Cloud: In community cloud, private clouds are combined together. It is built 
specifically for various communities having common concern.

 • Hybrid Cloud: In hybrid cloud, two or more clouds are combined together to form a single 
cloud. It is flexible and more secure.



 3. The Address bar of a browser shows the Uniform Resource Locator (URL) of the opened page. 
If you want to visit a different page of a website, an address needs to be typed in the Address 
Bar and the Enter key needs to be pressed.

  

 4. Navigation Buttons: Most of the times after clicking on a link, you might want to go back to 
the previous page. You can go to the previous page by clicking on the browser’s Back button. 
Forward button can be pressed to go back to the same page again. Browser 
uses web cache to display a page. Web cache stores recently viewed web 
pages to avoid downloading it again. Refresh button is used to load the 
page again.

 5. Browsing History: Suppose you visited a page a few days ago, but forgot to bookmark it. 
You can find the page again by checking the history of the browser. History includes a list 
of websites that have been visited through that browser. To view the history, click on the 
Customise and Control Google Chrome icon and select the History option. You can either 
view the history or you can delete it. To view history, simply click on it. To delete history, click 
on the check box and click on the displayed Delete option.



7. Introduction to E-mail
A. Fill in the blanks.

 1. ___________________ is a method of sending and receiving messages using a computer 
that has an Internet connection.

 2. An e-mail address consists of three parts: the __________, the _________ and the ________.
 3. _______ allows you to send the same message to another person at the same time.
 4. The word __________ is derived from two words, Internet and Etiquette.
 5. After finishing your work, never forget to ___________ from your account, else your account 

can be misused.

B. State whether the following statements are True or False. 

 1. E-mails are not free of cost.
 2. Bcc allows you to send the same message to several people at the same time.
 3. You cannot send pictures, text or sound as attachments through your e-mail message.
 4. It is important to be alert while sending and receiving e-mails.
 5. You cannot reply to a received e-mail.

C. Match the columns.

  Column A  Column B
 1. Bcc (a) Carbon Copy
 2. Cc (b) Blind Carbon Copy
 3. E-mail (c) Internet etiquette
 4. Sign out (d) Electronic mail
 5. Netiquette (e) Close an e-mail account

D. Identify the different components of an e-mail in the given picture.

E. Answer the following questions.

 1. Write a short not on e-mail.
 2. What are the advantages of an e-mail?
 3. What are the disadvantages of an e-mail?
 4. Write about the components of the window that appears when we hit the Compose button.



Answers to Worksheet

A. 1. Electronic mail or e-mail
 2. Username, @ symbol, domain name
 3. Cc
 4. netiquette
 5. sign out

B. 1. False 2. True 3. False 4. True 5. False

C. 1. (b)  2. (a) 3. (d) 4. (e) 5. (c)

D. 

Compose

Inbox

Drafts

Sent

E. 1. Electronic mail or e-mail is a method of sending or receiving messages using a computer with 
an Internet connection. An e-mail hardly takes a few seconds to reach its destination, and is 
sent and received free of cost on the Internet. We can also attach documents, videos, photos 
and music to an e-mail. To send and receive e-mails, you have to register yourself to an e-mail 
program by creating an e-mail account. Some of the popular web-based e-mail programs are 
www.gmail.com, www.hotmail.com, www.yahoomail.com and www.rediff mail.com. These 
e-mail programs act like an electronic post office.

 2. Following are the advantages of an e-mail.

 • Cheap: Once you are online, there is no further expense that you need to incur to send your 
mails. Nothing is charged for sending and receiving e-mails even though the message is 
sent across the world.

 • Easy to Store: Sent, received messages and attachments can be stored safely, logically and 
reliably in your mail server.

 • Easy to Use: Sending and receiving messages is simple. You only need to register yourself 
first.

 • Easy to Delete: Incoming messages have a subject line which helps you to delete them 
without opening, if you find them unnecessary. 

 • Fast: E-mail is the fastest means of written communication. A message can reach any part 
of the world in a fraction of a second just with the click of a mouse.



 • Global: Web-based e-mail means you can access your messages anywhere when you are 
online.

 • Information on Your Fingertips: Storing data online means there is no need for keeping 
files and folders. You can access information far quicker if you learn how to use e-mail.

 • Content: An e-mail message may consist of a few lines or thousands of lines. 

 • Material Communicated: Not only text messages, but also pictures, videos and sounds can 
be sent via e-mails.

 • Paperless: As the medium is electronic, therefore no paper is required to write or paste the 
mail.

 3. Following are the disadvantages of an e-mail.

 • Emotional Responses: Some e-mails may upset you or cause anger and discomfort.

 • Lack of Personal Touch: E-mails lack the personal touch that a handwritten card or a letter 
gives in informal situations.

 • Viruses: A virus can seriously aff ect your computer and destroy your data. If you want to 
use an e-mail, you should avoid reading mails from unknown senders.

 • Misinterpretation: Due to lack of facial expressions and emotions, there may be 
misunderstanding while interpreting the e-mails.

 4. Following are the components that appear when we click on the Compose button.

 • To: An e-mail address of the recipient is entered in this box. If the details of the recipient 
are not entered, then the e-mail cannot be sent.

 • Subject: Subject of the message is entered in this box. Recipients can see the subject of 
the mail in the summary of their incoming messages.

 • Cc: Cc stands for carbon copy. Here, the e-mail address of the person to whom you would 
like to send the copy of your mail is entered. This is optional.

 • Bcc: Bcc stands for Blind Carbon Copy. Here you enter the e-mail address of another 
recipient who receives the copy of the e-mail, but whose name and address are hidden 
from all other recipients. This is also optional.

 • Body: The main content of the message is typed in this box. The message can be of any 
length.

 • Attachment: Any type of attachment in the form of a document, photo, audio or video 
can be sent along with a mail. Names of the attached files are displayed in the Attachment 
box.



8. Introduction to HTML5
A. Fill in the blanks.

 1. _________ is an interpreter-based, platform-independent language.

 2. HTML elements are of two types: __________ elements and _________ elements.

 3. HTML tags are surrounded by two symbols < (less than) and > (greater than) which are 
called______________.

 4. _______________ enables you to change the colour, font, size and alignment of the text on a 
web page.

 5. The attributes which are used with the ____________ are size, color and face.

B. State whether the following statements are True or False. 

 1. HTML is a set of instructions given to a web browser to describe the structure of a web page.

 2. HTML tags are case sensitive.

 3. HTML is tagged as a programming language, rather than a scripting language.

 4. The instructions in the form of text characters are called tags in HTML.

 5. By default, all headings in HTML are aligned to the right.

C. Match the columns.

  Column A  Column B

 1. HTML editors (a) Building blocks of a web page

 2. WYSIWYG (b) Programs used for creating web pages

 3. Text editors (c) What You See Is What You Get

 4. Web browsers (d) Wordpad and Notepad

 5. Tags (e) Used to view HTML documents

D. Complete the sentences.

 1. The element that has both the tags, i.e., the starting tag as well as ______________________
____________________.

 2. The element that only has a starting tag (i.e., ON tag) and no end tag (i.e., OFF tag) is call
ed________________________________.

 3. The <HEAD> element is a container element for metadata (data about data) and is placed 
between_________________________________________.

 4. An attribute for a tag is always specified inside ___________________.

 5. An HTML document must always begin with ________________.

E. Answer the following questions.

 1. What are the benefits of HTML?

 2. What is the structure of an HTML document?

 3. Write the steps to create an HTML document using the Notepad.



Answers to Worksheet

A. 1. HTML   2. container, empty  3. angular brackets
 4. Font element   5. Font element
B. 1. True 2. False 3. False 4. True 5. False
C. 1. (b)  2. (c) 3. (d) 4. (e) 5. (a)
D. 1. the ending tag is known as a container element
 2. an empty element
 3. the <HTML> tag and the <BODY> tag
 4. the opening tag
 5. an <HTML> tag
E. 1. HTML provides the following benefits.

 • HTML is easy to learn and execute as it is based on tags.

 • HTML is an interpreter-based language as its commands are executed instruction by 
instruction.

 • It is a platform-independent language which means it can be executed on any operating 
system and is supported by all browsers.

 • It allows the use of different tags to make the document look more attractive.

 • It provides paragraph alignment features. So, you can align your text as per your choice.

 • You can also insert images, tables and animated text or graphics on the web page using 
tags.

 • HTML also allows linking of different web pages.
 2. Following is the structure of an HTML document.
  <HTML>
  <HEAD>
  <TITLE> ... <\TITLE>
  </HEAD>
  <BODY>
  -----------------
  -----------------
  </BODY>
  </HTML>
 3. Follow these steps to create an HTML document using the Notepad.

 • Click on the Start button.

 • Scroll down the list and click on Windows Accessories.

 • Click on the Notepad option. The ‘Notepad’ window will appear.

 • In the Notepad, type the program given alongside.



9. Computer Viruses and Security
A. Fill in the blanks.

 1. A ________ is a computer program that attacks a computer and is written by virus 
programmers.

 2. A virus cannot infect a computer _________. It can only infect computer __________.

 3. A virus can infect the __________________ like Microsoft Word and operating system 
programs.

 4. ________________, ___________________, voice authentication, face recognition, 
______________and encryption are some authentication techniques.

 5. Viruses can spread through removable media, downloaded files and ___________________.

B. State whether the following statements are True or False. 

 1. A virus can copy itself, attach itself to other applications or files and infect a computer.

 2. Once the virus is in the computer memory, it usually affects any application you run.

 3. Firewalls can either be software or hardware but not a combination of both.

 4. Some popular viruses are Norton, Kaspersky, AVG, McAfee and QuickHeal.

 5. Antivirus programs check the files on your computer to detect the viruses and also remove 
them.

C. Match the columns.

  Column A  Column B

 1. Boot Sector Viruses (a) Sunday

 2. Trojan Horse (b) Michelangelo

 3. Program File Virus (c) Marburg

 4. Worm (d) Backdoor

 5. Polymorphic Virus (e) Stone virus

D. Explain the following.

 1. Fingerprint Recognition

 2. Voice Recognition

 3. Face Recognition

 4. Iris Recognition

 5. Encryption

E. Answer the following questions.

 1. What can a computer virus not do?

 2. What are the ways in which your computer can be affected by virus?

 3. What is computer security? What is the purpose behind securing our computer?

 4. Write a note on password protection.



Answers to Worksheet

A. 1. virus

 2. hardware, software

 3. executable program files

 4. Password protection, fingerprint authentication, iris recognition

 5. e-mail attachments

B. 1. True   2. True   3. False
 4. False   5. True

C. 1. (e)    2. (d)   3. (a)
 4. (b)    5. (c)

D. 1. Fingerprint Recognition: Here, a user’s fingerprint is used to identify and authenticate him/
her. A fingerprint sensor is used to create as well as capture the digital image of a fingerprint. 
This image is compared to the stored image of a verified fingerprint and if both these prints 
match, access is granted.

 2. Voice Recognition: Here, a user’s voice can be used to identify and authenticate him/her. Just 
like fingerprints, a user’s voice can also be captured.

 3. Face Recognition: The analysis of facial features is done by scanning a person’s face. It helps 
to authenticate an individual’s identity.

 4. Iris Recognition: Iris identification is done by scanning the iris of the eye. Iris recognition is 
one of the best ways of authentication in high-risk situations.

 5. Encryption: Encryption is the process of converting information into a form that is not 
readable by anyone. Encryption is done at the sender’s machine. Encryption is a common 
technique used to protect data from misuse. Data can be encrypted when stored or when 
being transferred over a network from one computer to another. Internet banking is an area 
where encryption is widely used. In Internet banking, sensitive information like passwords, 
and information about bank balances. are sent across the Internet. The data is encrypted at 
the point of origin and decrypted only at the destination computer. So, even if someone gets 
access to it, he/she will not be able to understand it.

E. 1. A virus cannot do the following things.

 • A virus cannot infect computer hardware like keyboard and monitor.

 • It cannot infect files which are written on a protected disk like CD-ROM.

 2. Some ways in which your computer can get infected by a virus are as follows.

 • By using infected CD or pen drive

 • Through e-mail attachments

 • Through files download from the Internet

 • Starting an infected application as it infects other running applications



 3. Computer security refers to the protection of computer-based hardware and software 
resources against unauthorised use or natural disaster. 

  The purpose behind securing our computer is to prevent the following.

 • Piracy of information

 • Damage to hardware or information

 • Unauthorised modification of information

 • Illegal access to information or resources

 4. Password protection is the most common method of authentication. In this method, all 
authentic users are given usernames and passwords. A password is usually a series of 
alphanumeric characters. The users use their unique combination of username and password 
to log in. This is known as logging in. Once they have finished their work, they can exit the 
system by logging out. Password protection is used as an authentication mechanism to gain 
access to personal computers, electronic mail boxes, online banking services and a wide 
variety of other systems. For security reasons, it is advisable to change one’s password from 
time to time.


